RGBlink VIEWSIZE THE WORLD

VSP 628PRO Quick Start

= Any signal input any signal output

= LOGO capture and standard test pattern built in

= 3Dsignals input and output processing

= Support EDID management

= Seamless switching between any signals

= Support dual 2K output

= Preview and program outputs separately

= Independently one input to two separately
output conversion

= User-defined output resolution

= Genlock and reference input

= Module based and expendable
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Product Introduction

VSP 628PRO is an advanced high performance control interface, seamless switching between
all-in-one video scaler, scan converter, switcher and the inputs, VSP 628PRO is one of the most
transcoder converting any input signal format to advanced and flexible signal processor in the
any output signal format. industry.

VSP 628PRO supports composite, component, VGA, VSP 628PRO is based on module based structure,
DVI signal and dual link, HDMI, DisplayPort, USB, its standard version comes with all the features
CVvBS and SD/HD/3G-SDI  signal  formats. you need and expect to find in old versions. In
Loop-through outputs are provided for the DVI and addition to the standard features, with different
SDI input and Genlock signals. With features like modules, you can reach more possibility and
LOGO capture and standard test pattern built in, 3D application range.

processing, EDID management, Web page control

System Connection

RGBIlink offers solutions to

Switcher
Wkt

demanding technical problems.

o . mm.m.«.«
Any application questions, or e .

UDP / USB
required further information, e
please contact with our I

customer Support Engineers.
VSP 628PRO System Connection Diagram
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Packing Configuration

Power Cord USB Cable DVI-D Cable SDI Cable

g

VGA to YPbPr Warranty Card & Screw Driver Antistatic Bag
Adapter USB Files

Sender Card QC Declaration
Holder

e— B

Note:

SDI cable supplied only when SDI Output module is factory fitted

AC Power Cable supplied as standard according to destination market.
USB is contained on the Warranty/Registration Card. Please keep.
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Hardware Orientation

Front Panel
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VIDEQ PROCESSOR

Button Instruction

button

MENU Menu button, push the button | 7 SDI3/VGA2/DVI2/HDMI2/USB1/CVBS1/DP1.2

for 3 seconds to lock panel signal source button
SCALE Scale button, push MENU and

SDI4/VGA3/DVI3/HDMI3/USB2/CVBS2/HDMI1
SCALE button for 3 seconds to | 8 4/ yoviy yusey/ ”
) .4 signal source button

switch language
FREEZE Freeze button LOGO LOGO and test pattern setting button

Single and double images switch ) .
PIP DIMMER Dimmer and effects setting button

button

. TAKE Seamless effect switch button, and LOAD
SDI1, SDI2 SDI signal source button ) ]
reuse button (except in switcher mode)
DVI DVI signal source button 0~9 Number button, for parameters setting
HDMI HDMII signal source button Knob Confirm and adjust OLED menus
. . OLED . .
DP Displayport signal source button Panel Show operation menu items
ane

VGA VGA or YPbPr signal source
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Back Panel
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Input Interface Output Interface
3 Genlock input BNC port 4 Genlock loop out BNC port
5.7 3G-SDl input BNC port 6.8 3G-SDI loop out BNC port
11 DVI input DVI-D port 12 DVI loop out DVI-D port
13 HDMI input HDMI-A port 14 HDMI loop out HDMI-A port
15 Displayport input port 17 DVI output DVI-D port
16 VGA input DB15 port 18 HDMI output HDMI-A
19 VGA output DB15 port
20 CVBS output BNC port (OC optional
Other Interface module)
1 10/100M interface RJ45
2 USB interface
9 S.V.D. H. U. C. HDMI_DP_4K2K_IN
optional module slots
10 Optional  module/sending  card
interface
21 Illuminated power switch
22 Power IEC-3 port
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Operating Instruction

System Operation Mode

VSP 628PRO has five operation modes, which are called SYSTEM MODEs, these include Standard, Dual 2K,
Switcher, Split and MinDelay.

System Modes

Standard

In standard mode, both output channels output the same signal and resolution.
PIP is available for use.
This is the default mode following a reset.

Dual 2K

Each of the two output channels can have individually have resolution and scale set.
There is no PIP in this mode.

Switcher

Using this mode enables Preview and Program operations, with the DVI (as standard) being the Program output
and HDMI being the Preview output.

Resolution of each output is the same, however, each program/preview can have scale independently set.

There is no PIP in this mode.

Split

Allows splitting a input signal across both output channels, and also provides setting where the source is to be
split across more than one device.
There is no PIP in this mode.

MinDelay

Is mainly for broadcast applications, for signal conversion with less than 1 frame delay.
There is no PIP in this mode.

Set the System Operation Mode

Go to the SYSTEM menu select the required SYSTEM MODE.
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For all SYSTEM MODES other the SPLIT, the VSP 628PRO will show “SYSTEM MODE SETTING...”, which will take
up to 30secs before the device is ready.

Single Image Switching

VSP 628PRO can realize seamless effects switching between two channels.

Push the signal button, and the signal will be switched to the output.

For example, the [SDI1] button light is on, it means the signal of output is SDI1, if user needs to switch to VGA
signal, push the [VGA] button, and the signal will be seamless cut or fade in fade out to the output. User can
adjust the switch speed in <Trans Time> option in <Transition>by pushing the [MENU] button.

PIP Setting

Enable the PIP function
VSP 628PRO supports seamless switch in single image and double images.
Push the [PIP] button, the button light is on, and enable the PIP function.
Select the signal in PIP
VSP 628PRO can output two same or different signals to the output, the settings are as follows:
1. Push the [PIP] button, and enable the PIP function.
2. Push the [SCALE] or [DIMMER] button, select <Layer Select>, and push the rotary knob to confirm. (User can
also select <Layer Select> in <Input> or <Output> option by pushing the [MENU] button.
3. Turn the rotary knob, and select main or sub image.
4. Select the signal, and the selected image will be switched to this signal.
Note

Note: PIP Setting is applied to Standard Mode.

Scale Setting

1. Push the [SCALE] button, and enter to the scale function menus.
2. Adjust the H size, V size, H/V size, H pos, V pos and scaling mode by turning the rotary knob or number
buttons.
3. If image quality distorts by improper operation, it can be recover by reset.
Note

In PIP mode, user need to select the image that to
set in <Layer Select> option before setting.

Image Size Setting

1. Push the [MENU] button, and enter to the menu items.
2. Turn the knob, and select <Input>, push the knob to confirm.
3. Turn the knob, select <Sizing Adjust>, push the knob to confirm.
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4. Adjust the H size, V size, H pos V pos, and mask top, bottom, left and right of the image by turning the rotary
knob or number buttons.
5. If image quality distorts by improper operation, it can be recover by reset.
Note

In PIP mode, user need to select the image that to
set in <Layer Select> option before setting.

Dimmer and Effects Setting

1. Push the [DIMMER] button, and enter to the menu items, which include dimmer and effects.

2. Dimmer setting: The adjustment range is 0~100.

3. Effects setting: The setting for effects include brightness, contrast, chroma, hue, color temperature, color
correction, gamma, brightness, H sharpness, V sharpness, noise reduction, Invert, Flip V, Flip H and Flip 90
Degree.

Note

User can also select <Effects> in <Qutput> option by
pushing the [MENU] button for setting.

Note

In Dual 2K mode, User need to select the channel in
<Channel Select> before setting.

For example, choose the signal of CHB:

1. Push the [MENU] button to enter to menu items.
2. Select <Output>, push the rotary knob to confirm.
3. Turn the rotary knob, and select <Channel select>.
4. Turn the rotary knob and select CHB.

5. Select the signal, and CHB will switch to the

selected signal.

Note

In Switcher mode, all the settings above are for

preview.

Split Setting

In split mode, user can set split parameters of single or multiple devices quickly. The split operations are as
follows:

Project: There is one LED display, the size is 3864x1152, divide into right and left halves, the left width is 1824
and the right width is 2040, we will cascade the two LED displays with one VSP 628PRO, and display a complete
picture in the whole screen.

(1) Connect the interface
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Connect the DVI signal to the DVI input interface, connect the DVI output to the left LED sending card, and
connect the HDMI output to the right LED sending card.
(2) Select the system mode

Push the [MENU] button to enter to the menu items, turn the rotary knob to select <System>:

Transition
->System

Logo
Display Setup

Push the knob to confirm, turn the rotary knob to select <System Mode>:

->System Mode
Ethernet
Input EDID
VFD Bright

Push the knob to confirm, turn the rotary knob to select <Split>:

System Mode
* Split

(3) Select the split mode
Turn the rotary knob in split menus, and select the split mode as <One Machine> or <Multi Machine>.

->0ne Or Multi One Machine

Select <One Machine>, push the rotary knob to confirm, turn the rotary knob, select the split mode, for
example, select <H One-To-Two>:

One Machine
* H One-To-Two

(4) Set the output format
Push the [MENU] button to enter to the menu items, turn the rotary knob and select <Output>.

o RGElink



Input
->Output

Custom Formats
Views

Push the rotary knob to confirm. Turn the knob to select <Output Format>, and set the output formats as
2048x1152 @60Hz.

Channel Select
->Qutput Format

CVBS Format

Out Auto Config (N/A)

The resolutions of the two outputs will change at the same time.

(5) Set the split parameters
After select the split mode, the OLED screen will show the split parameters, set the H total as 3864, set the V
total as 1152, set the first width as 1824, then turn the rotary knob, and select <Set Parameter>, push the
rotary knob to confirm.

->H Total
V Total
First Width
Set Parameter

(6) Save
Push the [MENU] button to enter to the menu items, turn the rotary knob and select <Views>.

Input

Output

Custom Formats
->Views

Push the rotary knob to confirm. Turn the rotary knob again and select <Save>.

Recall
->Save

Delete
Delay Recall

Push the rotary knob to confirm. Turn the rotary knob to select the save mode, for example, select File 4,
push the rotary knob to confirm.
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Save
->File 4

Set the LED Display Connection

VSP 628PRO can realize two connection as follows connecting the Port D or Port U of one sending card to LED
screen and connecting the both Port D and Port U of one sending card to LED screen (PORT A or PORT B is for
Colorlight, and PORT D or PORT U is for Linsn). The following are the detailed operation steps of the two
connections.

1. Connect the Port D or Port U of One Sending Card to LED Screen

(1) First, make sure that the device is in normal operation.

(2) Select the input source, for example, DVI.

(3) Connect the cable to Port U.

(4) Turn the rotary knob, and select <Display Setup>:

Transition
System

Logo
->Display Setup

(5) Push the rotary knob to confirm, turn the rotary knob, select <Card Type> in <Quick Connection> option,
push the rotary knob to confirm, turn the rotary knob, select the sending card type, for example, select Linsn
(VSP 628PRO supports Linsn and Colorlight sender card, for Nova sender card, it only support brightness and
Gamma adjustment). Shown as follows:

->Quick Connection
Senior

*Card Type
Brightness
Output Format
Quick Connection
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(6) After setting, turn the rotary knob, select <Quick Connection>, push the rotary knob to confirm for next
setting, shown as follows:

Card Type

Brightness

Output Format
->Quick Connection

->Sending Card
Receiving Card

(7) Turn the rotary knob, select <Receiving Card>, push the rotary knob to confirm. Turn the rotary knob again,
and select <Choose Cable>, push the rotary knob to confirm. Turn the rotary knob, select Port U and push
the rotary knob to confirm.

Sending Card
->Receiving Card

->Choose Cable
Horizontal Card
Vertical Card
Width

(8) Set the horizontal card, vertical card, width and height. For example, set horizontal card as 3, vertical card as
2, width and height as 120, shown as follows:

Choose Cable
->Horizontal Card

Vertical Card
Width
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->Height
Port Offset X
Port Offset Y

Connect Type

VERTICAL CARD 2

HORIZONTAL CARD 3

After setting, turn the rotary knob and select <Connect Type> according to actual connection mode. VSP

628PRO support 8 kinds of connection modes, they are E, E, EI, E, Lﬂ, ﬂJ, n-l and I—n

respectively.

Height
Port Offset X
Port Offset Y

->Connect Type

Save to receiver after choose the connection mode, observe the display screen and make sure if display
image is correct. If wrong, change the connection types. Then connect the Port D or Port U of One Sending
Card to LED Screen is finished.

(9) The setting for port D is same as the above setting.
Rendering is as follows:

——

PR Ty - T :
ﬁ‘_’ o2 v e : B Sam .o

2. Connect the Port D and Port U of One Sending Card to LED Screen
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(1) First, make sure the device is in normal operation.

(2) Select the input source, for example, DVI.

(3) Connect one cable to Port D, the other one to U.

(4) Connect Port U to LED screen, the settings are same as Step 4 to Step 8 of “Connect the Port D or Port U of
One Sending Card to LED Screen”.

(5) Connect Port D to LED screen, the settings are as follows:
a. Turn the rotary knob, and select <Display Setup>:

Transition
System

Logo
->Display Setup

b. Push the rotary knob to confirm, turn the rotary knob, select <Card Type> in <Quick Connection> option,
push the rotary knob to confirm, turn the rotary knob, select the sending card type, for example, select
Linsn (VSP 628PRO supports Linsn and Colorlight sender card, for Nova sender card, it only support
brightness and Gamma adjustment). Shown as follows:

->Quick Connection
Senior

*Card Type
Brightness
Output Format
Quick Connection

c. After setting, turn the rotary knob, select <Quick Connection>, push the rotary knob to confirm for next
setting, shown as follows:

Card Type
Brightness

Output Format
->Quick Connection

14 RGElink



->Sending Card
Receiving Card

d. Turn the rotary knob, select <Receiving Card>, push the rotary knob to confirm. Turn the rotary knob again,
and select <Choose Cable>, push the rotary knob to confirm. Turn the rotary knob, select Port D and push the
rotary knob to confirm.

Sending Card
->Receiving Card

->Choose Cable
Horizontal Card
Vertical Card
Width

e. Turn the rotary knob, and select <Port Offset Y>, push the rotary knob to confirm. Turn the rotary knob,
Set Port Offset Y as 240 (Note: Port Offset Y = Vertical x Height, before we set vertical card as 2 and height
as 120). Shown as follows:

Height

Port Offset X
->Port Offset Y

Connect Type

f. Turn the rotary knob, and select <Connect Type>, shown as follows:

Height
Port Offset X

Port Offset Y
->Connect Type

Select the connection mode, the setting is same with Port U. Then connection of both the Port D and Port
U of One Sending Card to LED Screen is finished.
Rendering is as follows:
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Set the Output Resolution

Select the Output Resolution

1. Push the [MENU] button, and enter to the menu items, turn the rotary knob and select <Output>:

Input

->Output
Custom Formats
Views

2. Push the rotary to confirm, and enter to the menus as below:

->Qutput Format
CVBS Format
Out Auto Config (N/A)
Area of Interest

3. Push the rotary to confirm. Turn the rotary knob, select the output resolution according to actual need.

Output Format
->1920x1080p @60

Custom the Output Resolution

Push the [MENU] button to enter to the menu items, turn the knob and select <Custom Formats>, push the

rotary knob and confirm.
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Custom Formats
->1920%x1080x60.0

Use red number keys and knob
for enter

1. Enter digits of desired resolution by pushing the red number buttons. For example, input 1536 as following:

Custom Formats
*1536 %
Use red number keys and knob
for enter

2. After the digital, push the rotary knob will add x, means before x is the horizontal size. Same operation for
vertical size, For example, input 1536 as following:

Custom Formats
*1536x1536x%
Use red number keys and knob
for enter

3. After the digital, push the rotary knob will add x, means before the x is the vertical size, and after the x is the
refresh rate. Only digital 50 or digital 60 supports for the refresh rate. For example, input 60 as following. Use
the digital buttons to finish the settings.

Custom Formats
->1536%x1536x60.0

Use red number keys and knob
for enter

4. After input all the values, push the rotary knob to enable VSP 628PRO to output this resolution. VSP 628PRO
will take 5~10 seconds to enable this output resolution.

Capture LOGO

1. Push the signal button, and select the input signal.
2. Push the [SCALE] button, turn the rotary knob or numeric keys to set the size and position of the LOGO.

->H Size
V Size

H/V Size
H Pos
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->V Pos
Scaling Mode

Reset

3. Push the [MENU] button and enter to the menu items, turn the rotary knob and select <Logo>:

Transition

System
->Logo

Display Setup

4. Push the rotary knob to confirm. Turn the rotary knob again, select <Capture Logo>, and set “Capture Logo”
as “Enable”:

->Capture Logo
Logo Present

Capture logo will finished after a few seconds.

Using LOGO Button

Push the [LOGO] button, user can set the test pattern, the settings are as follows:

->Type
Raster Box

Diag Motion
AOI Raster Box

Type: Select the type of the Test Pattern to be displayed. Options are:

LOGO: Video frame captured as in the LOGO.

RAMPS: H RAMP, V RAMP.

COLOR BARS: 100% COL BAR, 75% COL BAR, SMPTE COL BAR.

GRIDS: 16*16 GRID, 32*32 GRID, BURST.

GRAYS: 50% GRAY, GRAY STEP1, GRAY STEP2, WHITE, BLACK.

Raster Box: Enable or disable the raster box function. If raster box is “ON”, the border is shown around the
image, which is for testing.

Diag Motion: Enable or disable Diagonal Motion of the selected test pattern.

18 RGElink



AOI Raster Box: If Raster Box (above) is “ON”, size settings in this menu for Box X, Box Y, Box Width and Box

Height are displayed. Select Reset to restore default settings. AOI raster box will display for all signals except
LOGO (Test Pattern).

Saving Views

VSP 628PRO provides 22 positions for saving or recording parameters. To save current parameters and settings:

1. Push the [MENU] button to enter to the menu items, turn the rotary knob, select <Views>, push the rotary
knob to confirm.

Input
Output

Custom Formats
->\iews

2. Turn the rotary knob, and select <Save>, push the rotary knob to confirm.

Recall
->Save

Delete

Delay Recall

3. Turn the rotary knob, and select the location that need to save, push the rotary knob to confirm.

Save
->File 3

Note

If position 1 is saved, this will be recalled and loaded
at power on.

Recall Saved Views

VSP 628PRO provides 22 positions for saving or recording parameters. To recall saved settings:

1. Push the [MENU] button to enter to the menu items, turn the rotary knob, select <Views>, push the rotary
knob to confirm.
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Input
Output

Custom Formats
->Views

2. Turn the rotary knob, and select <Recall>, push the rotary knob to confirm.

->Recall
Save
Delete
Delay Recall

3. The button on is ready for recall, and button flashes means just recall. Push the button on or turn the rotary
knob to select the location that need to recall, push the rotary knob to confirm.

Recall
->File 3

Press Number Keys to Enter

Note

User can only recall File 1 to File 10 by pushing the
button. Beyond File 10, please select the file by the
rotary knob.
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WEB SERVER Cross-platform Control Operation Interface

If users use Ipad or Iphone, they can input the website 192.168.0.100 (default) or 192.168.0.231 in Safari
browsers to operate. If users need to modify VSP 628PRO IP address, they can input corresponding modified IP
address.

If users use other device, they need to install webkit kernel browser, such as: apple Safari, Google Chrome or
Maxthon. Installation package provides Google Chrome browser (Windows version).

Note: Internet Explorer, Edge and Firefox are not supported.

Now take Google Chrome browser for example, specific steps are as follows:

Step 1: click to run Google Chrome browser, open the webpage and input 192.168.0.100 to operate:

C [1]192.168.0.100 =

-
L

Chrome

Step 2: Enter the default home page, the system provides 13 kinds of output resolutions for choose, blue stripe
means current selected output resolution. Selected, then VSP 628PRO will automatically update the output
resolution.
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55 AUDSP Conscle

€ & C [1192.168.0.100 70

1024 X 768 @ 50
1024 X 768 @ 60
1024 X768 @ 75
1024 X 768 @ 85
1152 X 864 @ 75
1280 X720 @ 25
1280 X 720 @ 24
1280 X 720 @ 23.98
1280 X 1024 @ 85
1280 X 720 @ 50
1280 X720 @ 30
1280 X 720 @ 29.97

1280 X 720 @ 59.94

1280 X 768 @ 60

Note

Users can freely switch the icons in title bar to set relevant

functions, following will introduce the relevant settings.

Step 3: Select "Input" icon in title bar, user can click the signal source that need, VSP 628PRO will automatically
update input signal source.

25 auDSP Console

& - C [1192.168.0.100 =

SDI

SDI2

DVI

HDMI

DP

VGA

USER1

USER2

LOGO/TP

Step 4: Select "Image" icon in title bar to scale the image, user can modify digital setting parameters and image
size and position easily through "-+" icon. Click "Set" after modify the digital, VSP 628PRO image will display the
latest Settings.
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5 wDSP Cansdle A

€ - C [1192.1680.100 ol =
Scale Setting

Seale X 0 =

Scale Y 0 +

Scale Width 800 "

Scale Height 600 +

Set

Step 5: Select "PIP" icon in title bar. When the PIP sliding block icon is grey, then it is single channel picture
mode, and if image selection is gray, then image 1 is default for single image output image, and can't be chosen.

= e

72

25 AYDSP Console <Ly
€ & C [1192.168.0.100

pip Setting

pip -_—
W/

Mode PIP Top Left

Note

User can preset the image mode that switch the current single
picture mode to double-picture mode and the position of the

two images in the mode.

Drag the slider rolling ball, when the slide block is green, PIP starts.
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pip Setting
Mode PIP Top Left

Image Select Image2

Then user can set PIP location, in addition to system default PIP upper left picture, also can choose picture
above picture and picture edge picture.

5 AIDSP Console x =&l 2

« - ¢ [[)192.1680.100 7 =

PIP Top Left
POP

PBP

In PIP mode, the default imagel is the main image, image 2 for PIP sprite, click the corresponding image when
need to edit image 1 or image 2, the selected image with blue stripes, tick, as shown below: image 2 is selected,
all settings will for image 2. For example, you can switch "Input" icon in title bar to choose image 2 input source.
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Note

If image 1 and image 2 with the same input source, then it will

display the same picture in PIP.

Step 6: Image brightness setting, it is mainly for output image setting. If "Sync" is grey, you can adjust one color

alone, when "Sync" is green, it means it starts, drag one color, and the other two color values will change
accordingly to the same value.

29 nyDSP Console x Y
€ & C [1192.168.0.100 w2

Bright Setting

Note

User can adjust setting according to actual condition, the
function mainly suitable for the personage that is very
processional in image quality. Nonprofessional isn’t recommend
to the above operations, if distortion of image quality as of

improper operation errors, you can reset to the factory

initialization.
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Step 7: Image contrast setting, it is mainly for output image contrast. If "Sync" is grey, you can adjust one color

alone, when "Sync" is green, it means it starts, drag one color, and the other two color values will change
accordingly to the same value.

5 o5 Consele x

< € [1192.168.0.100 ve

Contrast Setting

Note

User can adjust setting according to actual condition, the
function mainly suitable for the personage that is very
processional in image quality. Nonprofessional isn’t recommend
to the above operations, if distortion of image quality as of
improper operation errors, you can reset to the factory

initialization.

Step 8: Save and Call function. User can save the parameters to UserModel and UserMode2, and can also load
UserModel and UserMode2 that saved before.

€ C | [1192.168.0.100

Save Call

UserMode1 [ ]

UserMode2

Call Save

Step 9: Page setting.
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Setting Version:1.09

[ Factorysewp | [ Repoot |

Language Auto

Key Lock @

Dimmer Q
0

Language will affect the next time and after reboot 1P will affect.

ouptinpet pip Eright Lag

First, choose the language according to user’s need. And the default is automatic identification.

faaane
w

€ <& € [11921680.100

Auto

English

FIL

Click "Set" after select the language (such as select Chinese), pay attention to system prompt "Language will
effect after the next time and after reboot IP will affect" (at green box); Now you need to refresh the page to

complete the setting.
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Setting Version:1.09

Language English

| FactorySetup | | Reboot |

Key Lock

Dimmer

Language will affect the next time and after reboot IP will affect.

If need to modify IP address, user can press MENU->SYSTEM ->Ethernet->IP, it will take effect after restart the
device.

5 auose Console AW =&

€ - C | [1192.168.0.100

o
n

Setting Version:1.09

Language English

| FactorySetup | || Rehoot |

Key Lock

Dimmer

Language will affect the next time and after reboot IP will affect.

Reset: If appear wrong operation, click "Reset" to factory default.
Key Lock: If slide block is gray, it is unlock, and VSP 628PRO keys can normally operate. And if slide block is green,
the VSP 628PRO keys locked, and user can't operate any button.
Dimmer: ALPHA transparency regulation. Drag ball to change the transparency value, transparency value is
between 0 ~ 100 levels.

Note

Operation is invalid in PIP mode.

Step 10: Log function is mainly for research and development personnel as debugging use.
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Enable
Clear
Sync

cMD DAT1 DAT2 DAT3 DAT4

0x00 0x00 0x00 0x00 0x00 [ Send ]
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VSP 628PRO Connect APP Control Operation

1. Download the APP

Click the link http://www.rgblink.cn/en/products_detail.aspx?id=261 to the VSP 628PRO home page, and click
the “Download” option to get the Apps links.
For iOS App, the dedicated link is https://itunes.apple.com/au/artist/rgblink/id958113921. Install the VSP

628PRO client App on Iphone or Ipad, shown as

SP 628PR |

. After the installation is completed, the Iphone or

Ipad will show the icon

2. APP Control Interface Introduction

H " NG—
WIFI Network cable

1. Prepare a router that with wireless internet and DHCP function, connect and set the router by computer
before connect to VSP 628PRO, and enable the IP and DHCP function. (For more details about setting, please
refer to router’s instruction).

2. Connect the LAN port of router to the LAN port of VSP 628PRO with the network cable.

3. Connect to the router by I0S or Android device, system default IP automatic access, use the web browser to
access “192.168.0.100”, the default IP address of VSP 628PRO, if the IP address is changed, please enter the
changed IP address. (Set path: MENU->System->Ethernet->IP), user can wirelessly control VSP 628PRO after
loading.

(1) Make sure the device is connected to the router, power on, after the device is stable,

turn on the mobile phone or IPAD APP to search and connect the device, as follows:
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GBlink

Processor Control

Find your device

(2) There are 2 device options after connect the device, DEMO is the presentation template that comes with
software, choose any one of them, as follows:

cancel  Find your device

VSP 628PRO

VSP 628PRO

(3) After connection, it enters to the processor manager interface, as follows:

€~ Processor Manager

[

And Load

R

Mask And Scale

nformation

(4) Click <Signal Select>, it supports 4 different modes, as follows:
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€« Signal Seclet <« Signal Seclet <« Signal Seclet <« Signal Seclet

- PIP DUAL |SWITCH STD - DUAL |SWITCH STD PIP -SWITCH STD PIP DUAL -

Kis @ @1 QD05:38°M [l China Mobilo 4G +++ 0.18K/s U ® .4 GD

Save And Load <« Save And Load

(6) Click <Image Setting>, user can adjust the parameters in preview mode, as follows:

17Ks © @4 @

Image Setting Image Setting <« Image Setting

Image Setting

eox -]

(7) Click <Mask And Scale>, user can mask and scale the image, as follows:
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<« Test Pattern Test Pattern Test Pattern
- l

(9) Click <Parameter Setting>, user can adjust the output resolution, as follows:

T 9.4 GDOSA1PM

€ Parameter Setting

(10) Click <Information>, user can view the device mode, serial number, IP address and module versions. User can

also click “Factory Reset” to reset to its factory settings.
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Information

Factory Reset
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Contact Information

Warranty:

All video products are designed and tested to the highest quality standard and backed by full 3 years parts and
labor warranty. Warranties are effective upon delivery date to customer and are non-transferable. RGBlink
warranties are only valid to the original purchase/owner. Warranty related repairs include parts and labor, but
do not include faults resulting from user negligence, special modification, lighting strikes, abuse(drop/crush),
and/or other unusual damages.

The customer shall pay shipping charges when unit is returned for repair.

Headquarter: S603~604 Weiye Building Torch Hi-Tech Industrial Development Zone Xiamen, Fujian Province,
P.R.C

Tel: +86-592-5771197
Fax: +86-592-5788216
Customer Hotline: 4008-592-315
Web:
~  http://www.rgblink.com

~  http://www.rgblink.cn
o E-mail: support@rgblink.com
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